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EXPRESS MAIL CERTIFICAT E 1\_ . .:J917774582US 
PATENT Attorney Docket No. 3125-4002 

UNITED STATES PATENT APPLICATION 

OF: KEITH R. McNALLY 
WILLIAM H. ROOF 
RICHARD BERGFELD 

FOR: INFORMATION MANAGEMENT AND SYNCHRONOUS 
COMMUNICATIONS SYSTEM WITH MENU 
GENERATION 

FIELD OF THE INVENTION 

This invention relates to an infonnation management and synchronous 

communications system and method for generation of computerized menus for restaurants and 

other applications with specialized display and synchronous communications requirements 

j..kiS related to, for example, the use of equipment or software with non-PC-standard graphical 

:__16 formats, display sizes and/or applications for use in remote data entry, information management 
~ 

;17 and synchronous conununication between host computer, digital input device or remote pager 
H.l 
Li.. ::J8 via standard hardwired connection, the internet, a wireless link, smart phone or the like. 

19 BACKGROUND OF THE INVENTION 

20 While computers have dramatically altered many aspects of modem life, pen and 

21 paper have prevailed in the hospitality industry, e.g., for restaurant ordering, reservations and 

22 wait-list management, because of their s implicity, ease of training and operational speed. For 

23 example, ordering prepared foods has historically been done verbally, either directly to a waiter 

24 or over the telephone, whereupon the placed order is recorded on paper by the recipient or 

25 instantly fi lled. 

490392_1 
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Although not previously adapted for wide-scale use in the hospitality industry, 

2 various forms of digital wireless communication devices are in common use, e.g., digital 

3 wireless messengers and pagers. Also in common use are portable laptop and handheld devices. 

4 However, user-friendly information management and communication capability not requiring 

5 extensive computer expertise has not heretofore been available for use in everyday life such as 

6 for restaurant ordering, reservations and wait-list management. Hundreds of millions of dollars 

7 have been spent on personal digital assistant ("PDA") development seeking to produce a small, 

8 light-weight and inexpensive device that could be adapted to such uses; yet none have yielded a 

0 9 satisfactory solution. 

~10 One of the inherent shortcomings of PDA type devices is that, as they strive for 
0 
1511 small size, low weight and low cost, they must compromise the size and clarity of the operator 
"F 

;:';12 display medium interface itself, which in most cases is one of a variety of LCD (liquid crystal 
;,oc; 

Q.l3 display) type devices. As the size of the display shrinks, the amount of information that may be 
. F; . ..., 
rJ4 displayed at any one point or time is commensurately decreased, typically requiring multiple 

~5 screens and displays to display information to the operator. This reduces the overall utility ofthe 

16 device. Additionally, the smaller display and keyboard results in a non-optimal operator 

I 7 interface, which slows down operation and is thus unacceptable for the time criticality of 

18 ordering, reservation and wait-list management and other similar applications. This necessitates 

19 many design compromises which in the aggregate have resulted in limited acceptance of PDA 

20 type devices in the restaurant and hospitality fields. 

21 Many of the negatives prevalent in earlier devices have been eliminated, but, to 

22 date, there is still no integrated solution to the orderinglwaitlist/reservation problem discussed 

23 above. With the advent of the Palm® and other handheld wireless devices, however, the efforts 

- 2-
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to make such devices ubiquitous have begun to bear fruit at least in some areas, e.g., personal 

2 calendars. However, substantial use of such devices in the restaurant and hospitality context has 

3 not occurred to date. As discussed above, at least one of the reasons PDAs have not been 

4 quickly assimilated into the restaurant and hospitality industries is that their small display sizes 

5 are not readily amenable to display of menus as they are commonly printed on paper or displayed 

6 on, e.g., large, color desktop computer screens. Another reason is that software for fully 

7 realizing the potential for wireless handheld computing devices has not previously been 

8 available. Such features would include fast and automatic synchronization between a central 

;""';; 9 database and multiple handheld devices, synchronization and communication between a World 
";::;:f 

:.Lj 
.;10 Wide Web ("Web") server and multiple handheld devices, a well-defined application program 

;d11 interface ("API") that enables third parties such as point of sale ("POS") companies, affinity 

~ 2 program companies and internet content providers to fully integrate with computerized 
~_;_= 

~13 hospitality applications, real-time communication over the internet with direct connections or 
·-· 

rJJ rd4 regular modem dialup connections and support for batch processing that can be done periodically 

g 5 throughout the day to keep multiple sites in synch with the central database. A single point of 

16 entry for all hospitality applications to communicate with one another wirelessly has also 

17 previously been unavailable. Such a single point of entry would work to keep all wireless 

18 handheld devices and linked Web sites in synch with the backoffice server (central database) so 

19 that the different components are in equilibrium at any given time and an overall consistency is 

20 achieved. For example, a reservation made online would be automatically communicated to the 

21 backoffice server and then synchronized with all the wireless handheld devices wirelessly. 

22 Similarly, changes made on any of the wireless handheld devices would be reflected 

23 instantaneously on the backoffice server, Web pages and the other handheld devices. 

490392_ 1 
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For the foregoing reasons, paper-based ordering, waitlist and reservations 

2 management have persisted in the face of widespread computerization in practically all areas of 

3 commerce. At most, computerization of these functions has been largely limited to fixed 

4 computer solutions, i.e., desktop or mainframe, because of the problems heretofore faced in 

5 configuring wireless handheld devices and maintaining database synchronization for such 

6 applications. Specifically, the unavailability of any simple technique for creating restaurant 

7 menus and the like for use in a limited display area wireless handheld device or that is 

8 compatible with ordering over the internet has prevented widespread adoption of 

0 9 computerization in the hospitality industry. Without a viable solution for this problem, 

w 
~10 
0 
0 11 

* ~2 w 

organizations have not made the efforts or investments to establish automated interfaces to 

handheld and Web site menus and ordering options. 

A principal object of the present invention is to provide an improved information 

management and synchronous communications system and method which facilitates user-

friendly and efficient generation of computerized menus for restaurants and other applications 

that utilize equipment with non-PC-standard graphical formats, display sizes and/or applications. 

16 A further object of the present invention is to provide an improved information 

17 management and synchronous communications system and method which provides for entry, 

18 management and communication of information from the operator as well as to and from another 

19 computer, Web page menu, remote digital device using a standard hardwired connection, the 

20 internet or a wireless link. 

21 A fu rther object of the present invention is to provide an improved information 

22 management and synchronous communications system which is small, affordable and 

- 4 -
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lightweight yet incorporates a user-friendly operator interface and displays menus in a readily 

2 comprehensible fonnat. 

3 A further object of the present invention is to provide a synchronous information 

4 management and conununications system which enables automatic updating of both wireless and 

5 internet menu systems when a new menu item is added, modified or deleted from any element of 

6 the system. 

7 SUMMARY OF THE INVENTION 

8 The foregoing and other objects of the present invention are provided by a 

-~ 9 synchronous infonnation management and communications system and method optimized for 

~0 simplicity of operation which incorporates menu generation for creation of menus to be used -0 
.&.11 with wireless remote handheld computer and PDA devices, the internet or any application where 
~ 
ll..~ 2 simple and efficient generation of menus is appropriate. The menu generation approach of the 

C?t 3 present invention includes a desktop software application that enables the rapid creation and 
~ 

"' ~4 building of a menu and provides a means to instantly download the menu configuration onto, 

~5 e.g., a handheld device or Web page and to seamlessly interface with standard point of sale 

16 ("POS") systems to enable automatic database updates and communication exchanges when a 

17 change or input occurs in any of the other system elements. To solve the above and other related 

18 problems, an infonnation management and communications system is provided which results in 

19 a dramatic reduction in the amount of time, and hence cost, to generate and maintain 

20 computerized menus for, e.g., restaurants and other related applications that utilize non-PC-

21 standard graphical formats , display sizes or applications. 

22 The menu generation approach of the present invention has many advantages over 

23 previous approaches in solving the problem of converting paper-based menus or Windows® PC-

- 5 -
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based menu screens to small PDA-sized displays and Web pages. In one embodiment, the 

2 present invention is a software tool for building a menu, optimizing the process of how the menu 

3 can be downloaded to either a handheld device or Web page, and making manual or automatic 

4 modifications to the menu after initial creation. 

5 The use of wireless handheld devices in the restaurant and hospitality industry is 

6 becoming increasingly pervasive as restaurant owners and managers become more aware of the 

7 benefits. With the proper wireless handheld system in place, restaurants can experience 

8 increased table turns from improved server productivity and shorter order taking and check 

_ 9 paying times. Restaurants and POS companies seeking to provide a wireless handheld interfac.e ...., 
;fj 
_;:10 to their desktop-based POS systems or a Web page equivalent face several challenges. These 
~ 
;..e 
Oil challenges include building a menu using their existing database and transferring the menu onto 

"' 
""" i:-i-12 handheld devices or Web pages that will interface with servers wirelessly or to 
w 
! 13 restaurants/customers over the internet. The menu generation approach of the present invention 
0 
~4 is the first coherent solution available to accomplish these objectives easily and allows one ... 
i-b 
.n15 development effort to produce both the handheld and Web page formats, link them with the -\0 

16 existing POS systems, and thus provides a way to tum a complicated, time-consuming task into a 

17 simple process. 

18 The information management and synchronous communications system of the 

19 present invention features include fast synchronization between a central database and multiple 

20 handheld devices, synchronization and communication between a Web server and multiple 

21 handheld devices, a well-defined API that enables third parties such as POS companies, affinity 

22 program companies and internet content providers to fully integrate with computerized 

23 hospital ity applications, real-time communication over the internet with direct connections or 

-6-
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8 

16 

17 

18 

19 

20 

21 

22 

23 

regular modem dialup coiUlections and support for batch processing that can be done periodically 

throughout the day to keep multiple sites in synch with the central database. 

The communication module also provides a single point of entry for all hospitality 

applications, e.g., reservations, frequent customer ticketing, wait lists, etc. to communicate with 

one another wirelessly and over the Web. This communication module is a layer that sits on top 

of any communication protocol and acts as an interface between hospitality applications and the 

communication protocol and can be easily updated to work with a new communication protocol 

without modifying the core hospitality applications. A single point of entry works to keep all 

wireless handheld devices and linked web sites in synch with the backoffice server applications 

so that the different components are in equilibrium at any given time and an overall consistency 

is achieved. For example, a reservation made online can be automatically communicated to the 

backoffice server and then synchronized with all the wireless handheld devices wirelessly. 

Similarly, changes made on any of the wireless handheld devices are reflected instantaneously on 

the backoffice server Web pages and the other handheld devices. 

BRIEF DESCRIPTION OF THE DRAWINGS 

The foregoing features and advantages of the present invention can be appreciated 

more fully from the following description, with references to the accompanying drawings in 

which: 

~~is a schematic representation of a window displayed on a computer display 

screen which shows a hierarchical tree menu, modifier window and sub-modifier window in 

confonnity red embodiment oflhe present invention. 

FIG. 2 is a schematic representation o f a modifier dialog box in conformity with a 

preferred embodiment of the present invention. 

- 7-
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16 

17 

18 

19 

20 

21 

22 

23 

~3 is a schematic representation of a menu category d ialog box in conformity 

with a preferred embodiment of the present invention. 

_)16: .. 4 is a schematic representation of a menu item dialog box in conformity with 

a preferred embodiment of the present invention. 

~ is a schematic representation of a display customization dialog box in 

d embodiment of the present invention. 

G. 6 is a schematic representation of a communications control window in 

embodiment of the present invention. 

. 7 is a schematic representation of a point of sale interface on a wireless 

handheld device for use in displaying page menus created in conformity with a preferred 

embodiment of the present invention. 

DETAILED DESCRIPTION OF THE INVENTION 

Most personal computers today run under an operating system that provides a 

graphical user interface ("GUI") for accessing user applications. A GUI is used in the preferred 

embodiment of the present invention. Through an interface of windows, pull-down menus, and 

toolbars, GUI operating systems have simplified PCs and have rendered computer technology 

more user friendly by eliminating the need to memorize keyboard entry sequences. In addition, 

GUis allow users to manipulate their data as they would physical entities. For example, a 

window can represent a file and the contents of the window can represent the records of the file. 

The window can be opened, closed, or set aside on a desktop as if it were an actual object The 

records of the file can be created, deleted, modified and arranged in a drag-and-drop fashion as if 

they also were physical objects. The most common GUI operating systems that provide this 

"object-oriented" environment for personal computers are Microsoft Windows® systems, 

- 8 -
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including Windows CE® for handheld wireless devices and the like. Generally, a particular 

2 application program presents information to a user through a window of a GUI by drawing 

3 images, graphics or text within the window region . The user, in turn, communicates with the 

4 application by "pointing" at graprucal objects in the window with a pointer that is controlled by a 

5 hand-operated pointing device, such as a mouse, or by pressing keys on a keyboard. 

6 The use of menus is conventional in GUls for software applications. Menus are 

7 typically utilized to provide end users of applications with available choices or processing 

8 options while using the applications. For example, in a typical desktop or interactive application, 

0 9 selection of a "file" from a menu bar may cause display of a context menu which provides "file" 

~ +' 0 options. File options can have additional subordinate or child options associated with them. If a 

0 
011 file option having subordinate options is selected, the child options are displayed in context in a 

+ 
~12 child menu or submenu proximate to the selected parent option. One or more of the child 
w 
• 13 options provided in the child menu may have further subordinate options. Thus, such a menu 
0 
1.0._ 4 I'IJ system comprises cascading sets of menus which are displayable in context to show the 

~ :rJ5 parent/child relationships between options of the context menu. A menu system of this type is 

..0 
16 incorporated into the preferred embodiment of the invention. 

17 The preferred embodiment of the present invention uses typical hardware 

18 elements in the form of a computer workstation, operating system and application software 

19 elements which configure the hardware elements for operation in accordance with the present 

20 invention. A typical workstation platform includes hardware such as a central processing unit 

21 ("CPU"), e.g., a Pentium® microprocessor, RAM, ROM, hard dri ve storage in which are stored 

22 various system and application programs and data used within the workstation, modem, display 

23 screen, keyboard, mouse and optional removable storage devices such as floppy drive or a CD 

- 9 -
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ROM drive. The workstation hardware is configured by software including an operating system, 

2 e.g. , Windows® 95, 98, NT or CE, networking software (including internet browsing software) 

3 and application software components. The preferred embodiment also encompasses a typical file 

4 server platform including hardware such as a CPU, e.g., Pentium® microprocessor, RAM, ROM, 

5 hard drive, modem, and optional removable storage devices, e.g., floppy or CD ROM drive. The 

6 server hardware is configured by software including an operating system, e.g., Windows® 95, 98, 

7 NT or CE, networking software (including Web server software) and database software. 

8 A computer workstation for use in the preferred embodiment also includes a GUI. 

0 9 As is conventional, the GUI is configured to present a graphical display on the display screen 

~ 
.;;10 arranged to resemble a single desktop. Execution of an application program involves one or 
0 
Ot I more user interface objects represented by windows and icons. Typically, there may be several 
.;: 
!-)2 windows and icons simultaneously present on the desktop and displaying information that is 
Vi 

d 3 generated by different applications. 

\0 
nJ 4 The window environment is generally part of the operating system software that 

~ 
~5 includes a collection of utility programs for controlling the operation of the computer system. 
;,0 

16 The computer system, in tum, interacts with application programs to provide higher level 

17 functionality, including a direct interface with the user. Specifically, the application programs 

18 make use of operating system functions by issuing task commands to the operating system which 

19 then performs the requested task. For example, an application program may request that the 

20 operating system display certain information on a window for presentation to the user. 

21 An aspect of the preferred embodiment of the information management and 

22 communications system of the invention is shown in FIG. l . FIG. l shows an example of the 

23 GUI provided by the operating system of the preferred embodiment of the present invention. 

- l 0-
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With reference to FIG. 1, the preferred embodiment includes an intuitive GUI l from which to 

2 build a menu on a desktop or other computer. A hierarchical tree structure 2 is used to show the 

3 different relationships between the menu categories 3 (e.g., soups, salads, appetizers, entrees, 

4 deserts, etc.), menu items 4 (e.g., green salad, chicken caesar salad, etc.), menu modifiers 5 (e.g., 

5 dressing, meat temperature, condiments, etc.) and menu sub-modifiers 6 (e.g., Italian, French, 

6 ranch, bleu cheese, etc.). 

7 The procedure followed in configuring a menu on the desktop PC and then 

8 downloading the menu configuration onto the POS interface on the handheld device in 

_ 9 conformance with the preferred embodiment is as follows. 
: r = 

~ 0 The menu configuration application is launched by clicking on the appropriate 

0 d I icon on the desktop display screen. FIG. I will then be displayed. There are three windows on 
... 

-T-
l=J2 the screen shown in FIG. I. The left window is the menu tree 7, also called the tree view. The 

E 13 top right window is the Modifiers window 8 and the bottom right window is the Sub-Modifiers 

>!lt4 window 9. The Sub-Modifiers window lists the sub-modifiers that correspond to the modifier 
ru 
?.s that is selected. The views on the right are referred to as list views. There are several ways of 
~ 

"'16 invoking a command, including using the menu options; using the context menu (right mouse 

17 click); using the keyboard or using the toolbar icons. For example, if it is desired to add a 

18 category to the menu, the following four options are available: ( 1) clicking on Edit, Add 

19 Category; (2) right mouse clicking on Menu, then clicking on Add Category; (3) highlighting 

20 Menu, then typing Ctrl +Tor (4) clicking on the Add Category icon on the toolbar. To add an 

21 item to a category, the following options are available: (I) highlighting the category to which it 

22 is desired to add an item and then clicking on Edit > Add Item; (2) right mouse clicking on the 

- 11 -
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desired category and then clicking on Add Item; (3) highlighting the desired category, then 

2 typing Ctrl +Nor (4) clicking on the Add icon on the toolbar. 

3 When building a menu, it should be kept in mind that the menu items are stored 

4 using a tree metaphor similar to how files are stored on a PC with folders and subfolders. The 

5 menu structure is similar to the Windows® File Explorer in the way the items are organized 

6 hierarchically. Below is an example of how an item may be configured: 

7 
8 
9 

10 
nil 

~; .f~l )C 
0 4 
OS 
+l6 

Menu 
>> Entrees 

>> Red Meat 
>> NY Strip 

>> Vegetables 
>> Tomato 
>> Lettuce 
Meat Temperature 
>> Medium Rare 

In the above example, Menu is the root. Entrees is a menu category. Red Meat is an Entree 

:_ts category. NY Strip is a modifier. Vegetable is a modifier. Meat Temperature is a modifier. 
~ 
.t1 rJ 9 Medium Rare is a sub-modifier of Meat Temperature. 

~0 The steps taken in building a menu are as follows: 

\0 
21 

22 

23 

24 

25 

26 

27 
28 

I. 

2. 

3. 

4. 

5. 

6. 

7. 

Add Modifiers; 

Add Sub-Modifiers and link them to the Modifiers; 

Create Menu categories; 

Add menu items to the categories; 

Assign Modifiers to the menu items; 

Preview the menu on the POS emulator on the desktop PC; 

Download the menu database to the handheld device. 

29 To add modifiers , a user clicks on the inside of the Modifiers window, then (I) 

30 clicks on Edit>Add Modifier; (2) Presses Ctrl + N; (3) right mouse clicks in the Modifiers 

31 window, then clicks on Add Modifiers or (4) clicks on the Add icon from the toolbar. If a menu 
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is being built from scratch, the procedure is to enter the Long Name, Short Name, Code and 

2 Price in the Modifier dialog box 10 shown in FIG. 2. The Long Name is the full descriptive 

3 name of the item. The Short Name is the abbreviated name that will be displayed on the 

4 handheld device. The Code is the numeric or alphanumeric code for the item. If there is an 

5 existing database, the existing database can be browsed and menu items retrieved from the 

6 database. Clicking on the Browse button will bring up the existing database of menu items. The 

7 item to be added is then selected and "OK" is clicked. The fields will then be filled with the 

8 information from the database. Clicking on OK again will add the item as a modifier. To delete 

..., 9 a modifier, the modifier is selected and the Delete key pressed on the keyboard. To edit a ..... .... 
~ 0 modifier, either the modifier is double clicked or the Enter key is pressed. 
-F 
0 
0 l Sub-modifiers represent the last level of modi fiers that can be assigned to a menu 
"" "i= 
H2 tree. To add sub-modifiers, the modifier to which sub-modifiers are to be assigned is selected. 

" 13 Then, the focus is set on the suo-modifier window by clicking inside the Sub-Modifier window 
~ -~4 as follows: (l) clicking on Edit>Add Sub-Modifier; (2) pressing Ctrl + N; (3) right mouse ru 
~5 clicking in the Sub-Modifiers window, then clicking on Add Sub-Modifiers or (4) clicking on the 
i,L..1 

·~16 Add icon from the toolbar. If a menu is being built from scratch, the procedure is to enter the 

17 Long Name, Short Name, Code and Price in a Sub-Modifier dialog box similar to the Modifier 

18 dialog box shown in FIG. 2. As with modifiers, the Long Name is the full descriptive name of 

19 the item. The Short Name is the abbreviated name that will be displayed on the handheld device. 

20 The Code is the numeric or alphanumeric code for the item. As before, if there is an existing 

21 database, the existing database can be browsed and menu items retrieved from the database. 

22 Clicking on the Browse button will bring up the existing database of menu items. The item to be 

23 added is then selected and OK clicked. The fields will then be filled with the information from 
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the database. Clicking on OK again will add the item as a sub-modifier. To delete a sub-

2 modifier, the sub-modifier is selected and the Delete key depressed on the keyboard. To edit a 

3 sub-modifier, either the sub-modifier is double clicked or the Enter key is pressed. 

4 Menu categories are created from the root. Some examples of categories are 

5 Appetizers, Soups, Salads, Entrees, Desserts, etc. The first step is to click on Menu in the menu 

6 tree window. Categories are added by (1) clicking on the Add Category icon from the toolbar; 

7 (2) clicking on Edit > Add Category or (3) pressing Ctrl + T. As shown in FIG. 3, Menu 

8 Category dialog box 11 then appears in which to enter the Long and Short names for the menu 

u 9 category. 

\fi 
~0 To add menu items to categories, the menu category which is being built is 

0 
0 1 clicked. For example, if items are being added to Appetizers, the Appetizers branch is clicked 
I"' 

"f" 

~2 on. Then the Edit> Add Hem is clicked on or Ctrl + N pressed. As before, if a menu is being 

~ l3 built from scratch, the procedure is to enter the Long Name, Short Name, Code, Prep Time, 
0 
~4 Recipe and Price into the Menu Item dialog box 12 shown in FIG. 4. The Long Name is the full 
i \.' 
j..k 
,.J:} 5 descriptive name of the item. The Short Name is the abbreviated name that will be displayed on 

,0 
16 the handheld device. The Code is the numeric or alphanumeric code for the item. Prep Time is 

17 the time it takes to prepare the meal and Recipe would include preparation methods and 

18 ingredients that are used in the preparation of the item. If there is an existing database, the 

19 existing database can be browsed and menu items retrieved from the database. Clicking on the 

20 Browse button will bring up the existing database of menu items. The item to be added is then 

21 selected and OK is clicked. The fields will then be filled with the information from the database. 

22 Clicking on OK again will add the item to the category. 
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Once the menu items have been entered, it may be desired to assign some 

2 modifiers to the menu items. For example, it may be desired to assign meat temperature to a 

3 steak order. To accomplish this, first the modifier to be assigned is selected, then the menu item 

4 on the tree view that is to be assigned the modifier is clicked on and then Edit > Assign Modifier 

5 is clicked on. Or, the modifier can simply be dragged and dropped onto the menu item to link 

6 them. A dialog box is then displayed asking if this modifier is a required modifier. If it is a 

7 required modifier, the display icon will be red but if it is a non-required modifier the display icon 

8 will be green. As many modifiers as are applicable can be assigned. [f any changes are made to 

:=. 9 the modifiers, those changes will be automatically reflected throughout the menu tree. -~rs 
';to Once the modi fiers have been entered, it may be desired to assign sub-modifiers 
~ 

fa, ,_, 
Of l to the modifiers items. For example, it may be desired to add Honey Mustard as a sub-modifier 

~ 
i-42 to Dressing. To accomplish this, first the modifier to be assigned a sub-modifier is selected, th~m 

• 13 the sub-modifier window is clicked on, then Edit > Add Sub Modifier is clicked on, Ctri+N 
;""; 

"""' 
:f\4 entered or the Add icon from the toolbar is clicked on. Or, the sub-modifier can simply be 
f'lj 

~ 5 dragged and dropped onto the modifier to link them. 
'=" 
~ 

16 When the menu has been completely configured, it can be previewed on a POS 

17 emulator on the desktop to verify that the menu is correctly configured before downloading it to 

18 the handheld device. To preview, File> Preview Database is clicked on or the Preview Database 

19 icon from the toolbar is clicked on. The handheld POS emulator on the desktop can then be run. 

20 If the configuration is deemed acceptable, the handheld device is connected to the desktop PC to 

21 ensure that a connection has been established; the POS application on the handheld device is 

22 exited and File > Download Database is clicked on or the Download Database icon from the 

23 toolbar is clicked on. If there is an existing menu database on the handheld device, the system 
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will ask if the existing database should be replaced. Yes ts clicked if existing database 

2 replacement is desired. 

3 A database function enables the creation of, e.g., a breakfast menu, lunch menu 

4 and dinner menu and downloading them to a handheld device. Functions available are (I) 

5 creating a new database; (2) opening an existing database; (3) saving a database under a different 

6 name. To access these functions, File is clicked on the menu bar. 

7 The preferred embodiment encompasses customized layout, views and fonts. To 

8 set the focus on the view it is desired to change, click inside the desired window. The main 

.... 9 customizing dialog box is accessed by clicking on View> Customize View. A dialog box 13, as 
u 

~0 shown in FIG. 5, will be displayed including tabs that allow the following options: selection of 
'f" 
0 
0 l Columns to display in the list view by choosing and arranging the fields to display in the 

+ 
loil2 Modifiers and Sub-Modifiers windows; fonnatting Columns by specifying the column widths 

• 13 and justification; selecting Filter allows restricting the list to display only the items that meet 
l""ii -~4 certain criteria. For example, display of modifiers with codes between 500 and 550. Selecting 
iu 
bl. J:J5 Sort allows sorting the modifiers or sub-modifiers according to any of the available fields such as ,6 Name, Code or Price. Selecting Style facilitates choice of font type, style, size, etc. To change 

17 the font in a particular window, click on View > Fonts or right mouse click in the desired 

18 window and then click on Fonts. To change the size of the windows, drag the borders of the 

19 windows to expand or contract the size of the windows. To change the column widths, simply 

20 drag the edge of the column headers to increase or decrease the column widths. 

21 A communications control program monitors and routes all commw1ications to 

22 the appropriate devices. It continuously monitors the wireless network access point and all other 

23 devices connected to the network such as pagers, remote devices, internet Web links and PO$ 
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software. Any message received is decoded by the software, and then routed to the appropriate 

device. No user action is needed during operation of the software once the application has been 

launched. To launch the communications control module, a Wireless Traffic icon is clicked on 

the desktop PC. When the program loads, the screen shown in FIG. 6 appears. Messages 

received are logged in the window 14 shown in FIG. 6 with a time stamp. The messages are also 

logged to a file on the hard drive. This provides a mechanism to monitor all traffic across the 

network (possibly useful for troubleshooting, or maintenance, but not necessary for normal 

operation). The program may be minimized so the screen is not displayed on the desktop, but it 

must be running for proper communications to exist between all devices on the network. 

As stated, the preferred embodiment of the present invention includes the use of 

and compatibility with GUI technology. A drag-and-drop approach is used for organizing the 

tree structure 2 in the generated menu. Drag-and-drop is also used for assigning modifiers 

(modifiers can be dragged from the modifiers window 5 and dropped onto the menu item 4 for 

assignment). In-cell editing results in fast editing of items in building the menus. Customizable 

fonts enable users to change font types, style and s ize. Customizable layouts enable users to 

resize windows, change icons and display preferences. The inventive approach provides for 

fully persistent storage between sessions, even if a session is improperly or abruptly terminated. 

Font and the tree state (i.e., which nodes are expanded/collapsed) are stored between sessions. 

Layout for modifiers and sub-modifiers list views ( filter, columns, formalting, font, e tc.) are 

stored between sessions. The last database used is likewise stored between sessions. Splitter 

views allow the user to see different views at the same time. Each view is displayed on its own 

section of the screen. Views can be resized via the keyboard or a mouse by simply dragging the 

splitter in the middle. 
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An automated function is provided to import existing POS databases into the 

2 inventive menu generation system and, as discussed above with respect to the detailed example 

3 of how to use the preferred embodiment, an automated download procedure is provided to 

4 transfer the desktop database onto a handheld device and/or Web page. Also as discussed, the 

5 preferred embodiment facilitates preview of the handheld device or Web page version of the 

6 POS menu on the desktop before downloading and configuration. Customizable desktop menu 

7 generation is contemplated, as discussed above, in the form of customizab\e fonts, columns, 

8 layouts, etc. The inventive approach also includes templates for common modifiers that can be 

"""'9 assigned to similar menu items. The preferred embodiment also supports multiple databases, 
lsi 
,f'> f 0 thus providing for the creation and storing of different menu databases on handheld devices such 

l.J 
0 I as breakfast, lunch or dinner menus. The user can then select the appropriate database to reflect 

j..f.{2 the time of day. 

FIG. 7 is a schematic representation of a point of sale interface 15 for use in 

displaying a page-type menu 16 created using the inventive menu generation approach. As can 

be seen from FIG. 7, the page menu is displayed in a catalogue-like point-and-click format 

whereas the master menu, FIG. l, is displayed as a hierarchical tree structure. Thus, a person 

17 with little expertise can "page through" to complete a transaction with the POS interface and 

18 avoid having to review the entire menu of FIG. I to place an order. A PDA or Web page format 

19 could appear like FIG. 7 or the display could be configured for particular requirements since 

20 fully customizable menu generation and display are contemplated. 

21 The POS interface on the handheld device supports pricing in the database or 

22 querying prices from the POS server. The POS device also can be customized with respect to 

23 "look and feel" for the particular version. As can be seen in FIG. 7, the POS interface provides 
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for billing, status and payment with respect to orders. A myriad of options can be provided 

depending on the application. 

Advanced database functions are provided in the preferred embodiment of the 

invention, including an automated download process onto handheld devices and/or Web sites. In 

the preferred embodiment, the menu generation system of the present invention uses an API 

called ActiveX Data Objects ("ADO") for database access. ADO is useful in a variety of 

settings. It is built on top of OLE DB and can be used to talk to databases and, in the future, any 

data source with any OLE DB driver. Advanced querying is supported. The database can be 

queried on virtually all fields. Queries can be built using SQL syntax for experienced users or 

can be created using a query builder which guides users through the creating process. Advanced 

error handling is supported. Errors occurring at run time can be trapped. A descriptive message 

is displayed to alert the user and provide error infonnation. However, the application does not 

tenninate when the errors happen. The source code is easy to maintain and modify, thus 

allowing for on time delivery of customized versions of the software. The advanced database 

functions produce well-designed databases that accommodate growth and scalability 

The inventive menu generation approach provides a solution for the pervasive 

connectivity and computerization needs of the restaurant and related markets. The inventive 

solution includes automatic database management and synchronization, PDA and handheld 

wireless operating system integration and optimization, wireless communications and internet 

connectivity, user interface design, and graphics design. 

In the preferred embodiment, the menu generation approach of the present 

invention uses Windows CE® as the operating system for the handheld devices. Windows CE® 

provides the benefi ts of a familiar Windows 95/98~ look and feel, built-in syncluonization 
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between handheld devices, internet and desktop infrastructure, compatibility with Microsoft 

2 Exchange®, Microsoft Office 9® and TCPIIP quick access to information with instant-on feature. 

3 Windows CE® provides a basic set of database and communication tools for 

4 developer use. However, interfacing with these tools to provide application specific results can 

5 be a complex task. In addition to the menu generation described above, a set of software 

6 libraries described herein in conformance with the present invention not only enhances the basic 

7 Windows CE® functionality by adding new features but also maximizes the fu ll potential of 

8 wireless handheld computing devices. Such features include fast synchronization between a 

0 9 central database and multiple handheld devices, synchronization and communication between a 
oD ao Web server and multiple handheld devices, a well-defined API that enables third parties such as 

f3. t POS companies, affinity program companies and internet content providers to fully integrate .. 
l=io 
LJ2 with computerized hospitality applications, real-time corrununication over the internet with direct 

C:P cormections or regular modem dialup connections and support for batch processing that can be 
I!) 
N.4 done periodically throughout the day to keep multiple sites in synch with the central database. 

'"" \Qs The synchronous communications control module discussed above provides a 
\0 

16 single point of entry for all hospitality applications to communicate with one another wirelessly 

17 or over the Web. This communications module is a layer that sits on top of any communication 

18 protocol and acts as an interface between hospitality applications and the communication 

19 protocol. This layer can be easily updated to work with a new corrununication protocol without 

20 having to modify the core hospitality applications. The single point of entry works to keep all 

21 wireless handheld devices and linked Web sites in synch with the backoffice server (central 

22 database) so that the different components are in equilibrium at any given time and an overall 

23 consistency is achieved. For example, a reservation made online is automatically communicated 
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to the backoffice server which then synchronizes with all the wireless handheld devices 

2 wirelessly. Similarly, changes made on any of the wireless handheld devices will be reflected 

3 instantaneously on the backoffice server and the other handheld devices. 

4 The software applications for perfonning the functions falling within the 

5 described invention can be written in any commonly used computer language. The discrete 

6 programming steps are commonly known and thus programming details are not necessary to a 

7 full description of the invention. 

8 A simple point-to-point wireless capability is contemplated which permits simple 

digital messages to be sent from the wireless handheld devices to a receiver in a beeper and/or 

valet parking base-station. The POS interface of FIG. 7 is representative of the display on a 

typical wireless device used in conformity with the invention. A simple protocol is used to 

acknowledge receipt of the message and thus simultaneous communication is not necessary, 

which reduces the cost of the wireless link. The range of the wireless link is determined by the 

characteristics of the radio transceiver. Adding a wireless link allows paging of beeper equipped 

customers directly from the operator interface on the wireless handheld devices and 

communication to and from various input/output transmitters and receivers to update the status 

17 of the order, reservation or other infonnation and thus further reduce the workload on the 

18 operator and enable operations to proceed much faster. This link could also be hardwired or 

19 otherwise implemented using any two-way messaging transport. 

20 A further aspect of the invention is the use of the menus generated in accordance 

21 with the described technique to place orders from wireless remote handheld devices or from 

22 remote locations through the internet. The World Wide Web is a distributed hypermedia 

23 computer system that uses the internet to facilitate global hypermedia communication using 
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specified protocols. One such protocol is the Hypertext Transfer Protocol ("HTIP"), which 

2 facilitates communication of hypertext. Hypertext is the combination of information and links to 

3 other information. In the context of the Web, hypertext is defined by the Hypertext Mark-up 

4 Language ("HTML"). The links or hyperlinks in a HTML document reference the locations of 

5 resources on the Web, such as other HTML documents. Another language used in creating 

6 documents for use on the Worldwide Web, to display on computer screens, or to create speech 

7 style sheets for use in, e.g., telephones, is the Extensible Mark-Up Language ("XML"). XML is 

8 a "metalanguage", i.e., a language for describing languages which was developed to eliminate 

0 9 the restrictions ofHTML. 

\0 ;w The Web is a client-server system. The HTML documents are stored on Web 

0 
0 l server computers, typically in a hierarchical fashion with the root document being referred to as 
~ 
ioit2 the home page. The client specifies a HTML document or other source on the server by 
w 
• 13 transmitting a Uniform Resource Locator (''URL") which specifies the protocol to use, e.g., 
0 
·f'3 N4 HTIP, the path to the server directory in which the resource is located, and filename of the 

\.!.: 
~5 resource. Users retrieve the documents via client computers. The software running on the user's 
~~:::: ,., 

16 client computer that enables the user to view HTML documents on the computer's video monitor 

17 and enter selections using the computer's keyboard and mouse is known as a browser. The 

18 · browser typically includes a window in which the user may type a URL. A user may cause a 

19 URL to be transmitted by typing it in the designated window on the browser or by maneuvering 

20 the cursor to a position on the displayed document that corresponds to a hyperlink to a resource 

21 and actuating the mouse button. The latter method is commonly referred to simply as "clicking 

22 on the hot-spot" or "clicking on the hyperlink". The hyperlink methodology is contemplated for 

23 use in accordance with the preferred embodiment to transmit orders via the intemet. 
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Web server application software exists that enables a user to shop for and order 

merchandise. Such systems are sometimes referred to as electronic merchandising systems or 

virtual storefronts. Systems that enable a user to choose among several retailers' goods are 

sometimes referred to as electronic malls. An electronic retailer's or electronic mall operator's 

Web server provides HTML forms that include images and descriptions of merchandise. The 

user may conventionally search for an item by entering a key word search query in a box on a 

form. When a user selects an item, the server may provide a linked form that describes that item 

in further detail. The user may also conventionally enter ordering information into boxes on the 

form, such as the type and quantity of the item desired. The information entered by the user is 

transmitted to the server. The user may select multiple items in this manner and then enter a 

credit card number to pay for the purchases. The retailer processes the transaction and sh.ips the 

order to the customer. As can be appreciated, ordering merchandise can also be done from 

menus. The generation of menus of items or merchandise for sale over the internet is readily 

accomplished by the menu generation approach of the present invention. 

Searching for items that the user is interested in purchasing is insufficient in prior 

merchandising systems. Database management programs use index searching to facilitate rapid 

searching of large amounts of data. The creator of the database may instruct the program to use 

specified fields in the database as indexed or key fields. The program locates all terms in the 

database that appear in the indexed fields and stores them in an index table. Each entry in the 

index table includes a term and corresponding pointer to the location in the database where the 

term is found. If a user initiates a search for a term that is present in the index table, the program 

can locate the instances of that term in the database with exceptional speed. Users who are 

familiar with the particular database they are searching will generally know which fields are 
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indexed and will know the format of the data in those fields. For example, a user of a database 

2 containing the inventory of a bookstore may know that users can search for the names of authors 

3 of books and that a user who wishes to do so should enter the author's last name first. A user 

4 having such knowledge will therefore be able to search efficiently. Users of electronic 

5 merchandising systems, however, are generally end-consumers who have no knowledge of a 

6 merchant's database. If, as is very likely, such a user initiates a search for a term that is not 

7 present in the index table, the program must sequentially search through all records in the 

8 database. Sequential records are typically linked by pointers. Using pointers in this manner is 

O 9 very demanding on server resources, resulting not only in an exceptionally slow search, but also 

\0 
,;J 0 creating a bottleneck for other processes that the server may be executing. The menu generation 

01 1 approach of the present invention can be used to create customized menus from a database that 
~ 
~2 includes every item of merchandise the vendor has for sale. In this manner, customers can scan 
Uti 

:.J3 the generated menu much more readily than they could view the entire database and the 
u .... 
~4 necessity of having familiarity with the database is eliminated as well, reducing the need for 
!\.! 
I' 
~ 

-t[J5 resource intensive pointers. 

16 While the preferred embodiment of the invention is for the generation of 

17 restaurant menus and the like, the broad scope of the invention is far greater. For example, 

18 menus generated in accordance with the invention can be used in the desktop computing 

19 environment in association with the operating system or application programs. One such use is 

20 to facilitate the creation of user personalized file structures for general desktop use. Another use 

21 is to facilitate the location of customized menus from master menus for use in association with 

22 application software to make the execution of the application software more efficient by, e.g., 

23 eliminating the necessity of querying or checking every tree branch in the master menu file 

4903?2_1 

Petitioners' Exhibit 1006, Page 30 



structure in response to user input or other criteria and to create handheld/PDA compatible 

2 versions of the software. 

3 While the preferred embodiment of the invention includes the selection of items 

4 from a master menu wherein the master menu is displayed using a graphical user interface, it is 

5 to be appreciated that any means for displaying the master menu to the user and generating 

6 another menu in response to and comprised of the selections made is encompassed by the 

7 contemplated invention . The invention encompasses the selection of nontextual symbols, 

8 characters, icons and the like, in addition to text, from a hierarchical tree menu or the like for 

O 9 generation of another menu comprised of such items. 

;fj 
.po It is also within the scope of the invention to generate menus automatically in 
0 
0.1 response to predetermined criteria. For example, in the restaurant menu generation embodiment, 
"" 

""' '"'2 a modified menu can be generated to comply with a particular specification or group of criteria 
n~ = 
:.J-3 such as, e.g., "dinner", "low cholesterol", "low fat", " fish", "chicken", or "vegetarian". In this 
w 
~4 embodiment, only items from the master menu that satisfy specified parameters will be included 

i-f. d5 in the generated menu. The selection process could involve selection of master menu items 
\0 

16 based on tags or identifiers associated with the items or by checking every master menu item 

17 against a dictionary of items acceptable for inclusion in tbe modified menu. It should also be 

18 appreciated that the invention encompasses any combination of automatic and manual user 

19 selection of the items comprising the generated menu. For example, a user might specify criteria 

20 which would further control automatic selection or the user could manually select some items 

21 with automatic selection of others. The menu generation aspect of the invention is equally 

22 applicable to table-based, drive-thru, internet, telephone, wireless or other modes of customer 

23 order entry, as is the synchronous communications aspect of the invention. 
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The inventive concept encompasses the generation of a menu in any context 

2 known to those skilled in the art where an objective is to facilitate display of the menu so as to 

3 enable selection of items from that menu. The restaurant menu generation embodiment is but 

4 one example of a use for the inventive concept. Likewise, displaying menus generated in 

5 accordance with the invention on PDAs and Web pages to facilitate remote ordering are but a 

6 few examples of ways in which such a menu might be used in practice. Any display and 

7 transmission means known to those skilled in the art is equally usable with respect to menus 

8 generated in accordance with the claimed invention. 

i""; 9 In the more general situation, menus can be generated in accordance with the -\0 
.po present invention in a variety of situations. For example, the usable file structure for a particular 
0 
Q I data processing application can be dictated by the user or an application program prior to or 

!;.2 during the execution of the application program. Efficiencies with respect to computational 
w 
C:J 3 speed and equipment, e.g., storage and processor, usage can thus be achieved along with the 

~4 facilitation of display of the generated menu. 
p.i. 
..;J5 While the best mode for carrying out the preferred embodiment of the invention 
~ 

1.6 has been illustrated and described in detail, those familiar with the art to which the invention 

:7 relates will recognize various alternative designs and embodiments which fall within the spirit of 

.8 practicing the invention. The appended claims are intended to cover all those changes and 

.9 modifications falling within the true spirit and scope of the present invention. 
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That which is claimed is: 

l. An information management and sync onous communications system for 

4 

5 
6 

7 
8 

generating menus comprising: 

a. a central processing unit, 

b. a data storage 
processing unit, 

c. an operating system 
interface, 

ected to said central 

eluding a graphical user 

9 d. a first menu stored on s id data storage device, 

C\o e. application software r generating a second menu from 
"9 l ! said first menu, 
.;- ' 
3-2 wherein the application software facilitate generation of the second menu by allowing 

fl3; selection of items from the first menu, ad tion of items to the second menu and assignment of 
!"" 

w 
s 14 parameters to items in the second men using the graphical user interface of said operating 

o · 
;,CIS system. 
ru 
t-16 ; An information management and synchronous conununications system in 
ID\ 
~7 · accordance with claim I, erein the second menu is a restaurant menu. 

18 3. An inform · n management and synchronous conununications system in 

19 accordance with claim I, wherein these nd menu is capable of being displayed on the display 

20 screen of a wireless computing device. 

21 4. An information management d synchronous communications system in 

22 f accordance with claim 3, wherein selections from the econd menu are capable of being 

23 transmitted to a receiving computer by wireless link. 

--· 
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5. An information management and synchronous communications system in 

2 accordance with cl · m I, wherein the second menu is capable of being displayed on display 

3 

4 6. formation management and synchronous communications system in 

5 accordance with claim 5, whe in the computer network is the intemet. 

6 7. An inform ion management and synchronous communications system in 

7 accordance with the second menu are capable of being 

8 transmitted to a receiving computer via e internet. 

8. An information man ement and synchronous communications system in 

accordance with claim 1, wherein the seco is created in conformity with hypertext 

markup language or extensible markup language. B 01 
~ 
~2 
w 

9. An information management d synchronous communications system in 

accordance with claim 1, wherein the second menu ove "tes the first menu. 

I 0. The information management and s chronous communications system of 

j-6 
'I!J-5 claim I , wherein the first menu and the second menu are bo capable o f being displayed in the 

\0 
16 same window on the display screen. 

17 I I. The information management and synchro us communications system of 

18 claim I, wherein the items comprising the second menu are a subse of the items comprising the 

19 first menu. 

w..(};~ > . 12. An on fonnat ion management 

~neratmg menus compnsmg: 

d synchronous communications system for 

22 a. a microprocessor 

23 b. 

24 c. a data and in ruction input device, 

- 28 -
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1 
2 
3 
4 

5 

6 
7 

8 

d. 

e. 

f. 

g. 

a data storage device for storing information and 
instructions entered t ough said data and 
instruction input means o information generated by 
said microprocessor, 

an operating system, 

a master menu store on said data storage device for 
generating a modifi d menu, and 

9 wherein said microprocessor, operating syste and application software are operative to display 

10 the master menu on the dispiay device i response to instructions programmed into said 

microprocessor, operating system, applicati n software and information and instructions entered 

through said data input device, and erein said microprocessor, operating system and 

application software are operative to eate the modified menu from said master menu in 

response to information and instruction entered through said data and instruction input device. 

13. e information management and synchronous communications system of 

claim means for transferring the modified menu to a digital computing 

device. B 
14. management and synchronous communications system of 

19 claim 13, wherein the digital computing vice is a wireless handheld device. 

20 15. The information mana ment and synchronous communications system of 

21 claim 12, further compris ing means for downloa · g the modified menu to the internet or a Web 

22 page. 

24 claim 15, further comprising means for converting the ified menu to hypertext markup 

25 language or extensible markup language . 

. 29 -
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1 

17. The infonnation management and synchronous communications system of 

2 claim 15, wherein the ems comprising the modified menu are a subset of the items comprising 

3 ( the master menu. 

4 \ 18. ation management and synchronous communications system in 

5 accordance with claim 12, wherein aid operating system includes a graphical user interface and 

6 wherein said microprocessor, operating stem and application software are operative to generate 

7 the modified menu by facilitating selection f items from said master menu using the graphical 

8 user interface of said operating system. p 
o9 
tD 
.po 
0 
01 
~ 
' ' CF 
~3 w 

~4 
J.i. 
t!!S 
..0 

16 
17 

18 
19 

20 
21 
22 
23 
24 

25 
26 
27 

19. An infonnation management d synchronous communications system in 

accordance with claim 12, wherein said master menu is ganized in a hierarchical tree structure 

having branches comprising menu items and wherein the odified menu is at least partially 

generated by selecting items from the branches of the tree struct e. 

/ ~ An infonnation management and synchronous communications system for 

generating and transmitting menus comprising: 

490392_1 

a. a central processing unit, 

b. a data storage device cormected to said central 
processing unit, 

c. an operating system including a graphical user 
interface, 

d. a first menu consisting of menu categories, said menu 
categories consisting of menu items, said first menu 
stored on said data storage device and displayable in a 
window of said graphical user interface in a hierarchical 
tree fonnat, 

e. a modifier menu stored on said data storage device and 
displayable in a window of said graphical user 
interface, 
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I 
2 
3 

4 
5 
6 

7 

8 

9 

10 

19 

20 

21 

22 

23 

24 

f. a sub-modifier menu stored on said data storage device 
and displayable in a window of said graphical user 
interface, and 

g. application software for generating a second menu from 
said first menu and transmitting said second menu to a 
wireless handheld computing device or Web page, 

wherein the application software facilitates the generation of the second menu by allowing 

selection of catagories and items from the first menu, addition of menu categories to the second 

menu, addition of menu items to the second menu and assignment of parameters to items in the 

second menu using the graphical user interface of said operating system, said parameters being 

selected from the modifier and sub-modifier menus. 

An information management and synchronous communications system in 
I 

accordance with claim)6: wherein the second menu is a restaurant menu. 

5 Jlf. An information management and synchronous communications system in 

l 
accordance with c laim~ wherein the second menu is capable of being displayed on the display 

screen of a wireless computing device. 

~~ )2f'- An ]fonnation management and synchronous communications system in 

accordance with claim p'. wherein selections from the second menu are capable of being 

transmitted to a receiving computer by wireless link. 

~Y. An information management and synchronous communications system in 

I 
accordance with claim JK wherein the second menu is capable of being displayed on display 

screens of computers in a network. 

~)( An . ~ . d h . . . 
7

_. maormat10n management an sync ronous commumcat10ns system m 

accordance with claim~ wherein the computer network is the internet. 

- 31 -
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2 

3 

4 

5 

6 

7 

8 

w 
!!(3 
0 

~4 

accordance 

5""~ . fi . d hr . . . /~· An m ormation management an sync onous commurucat10ns system m 

with claim}. wherein selections from the second menu are capable of being 

transmitted to a receiving computer via the internet. 

</ )l(: An information management and synchronous communications system in 

I 
accordance with claim )H: wherein the second menu is created in conformity with hypertext 

markup language or extensible markup language. 

r 'pt: An information management and synchronous communications system in 

' accordance with claim.J<f, wherein the second menu overwrites the first menu. 

/tJ { ,7 The information management and synchronous communications system of 

claim Jf.f, wherein the first menu and the second menu are both capable of being displayed in the 

same window on the display screen. 

tjH. The information management and synchronous communications system of 
{ 

claim y: wherein the menu categories and items comprising the second menu are subsets, 

respectively, of the menu categories and items comprising the first menu. 

3 I. In a computer system having an inp t device, a storage device, a video 

ldisplay, an operating system including a graphical user nterface and application software, an 
I 
i 

17 information management and synchronous communica ons method comprising the steps of: 

18 a. outputting at least one win ow on the video display; 

19 
20 

21 

22 
23 

24 
25 
26 

490392_ 1 

b. outputting 
display; 

c. displaying a cursor o 

in a window on the video 

d. selecting items fro the fi rst menu with the input 
device or the graph· al user interface; 

e. inserting the ite selected from the fi rst menu into a 
second menu, t e second menu being output in a 
window; 
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1 ( 
2 
3 \ 

4 

f. optionally adding addi~ion I items not included in the 
first menu to the second nu using the mput device or 
the graphical user interfa ; and 

g. storing the second men on the storage device. 

5 ) The method of claim 31, further comprising the step of transferring data or 

! 
6 1 instructions represent ·ve of the second menu to a remote digital device or Web page. 

! 

7 
l 

33. ethod of claim 32, wherein said data or instructions representative 

8 i of the second menu are trans£ ed by a wireless link. 

I 

9 ! 34. of claim 31, wherein the selected items and optional 

additional items are inserted into a se nd menu which is displayed in the same window as the 

first menu. {; 

35. The method of claim , comprising the further steps of selecting at least 

one item from the second menu and transmitting t least one item selected to another computer. 

36. The method of claim 35, erein at least one item selected from the 

second menu is transmitted to another computer by wi less link or the internet. 

37. The method of claim 32, wherein he second menu is displayed on the 

remote digital device or Web page in page format. 

18 38. The method of claim 31, wherein the s 

19 menu. 

20 39. The method of clai m 31, wherein the items c pris ing the second menu 

21 are a subset o f the items comprising the first menu. 

22 I cje: An information management and synchronous communications system for 

23 use with wireless handheld computing devices and the internet comprising: 

24 a. a central database containing hospitality applications and data, 

- 33-
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2 

3 

4 

5 

6 

7 

8 

17 

18 

19 

20 

21 

22 

23 

b. at least one wireless handheld computing device on which hospitality 

applications and data are stored, 

c. at least one Web server on which hospitality applications and data are 

stored, 

d. at least one Web page on which hospitality applications and data are 

stored, 

e. an application program interface, and 

f. a communications control module, 

wherein applications and data are synchronized between the central data base, at least one 

wireless handheld computing device, at least one Web server and at least one Web page; wherein 

the application program interface enables intergration of outside applications with the hospitality 

applications and wherein the communications control module is an interface between the 

hospitality applications and any other communications protocol. 

1 ¥ The information management and synchronous communications system of 

claim ~herein the communications control module provides a single point of entry for all 

hospitality applications and wherein the single point of entry allows the synchronization of at 

least one wireless handheld computing device and at least one Web page with the central 

database so that at least one handheld device, at least one Web page and central database are 

consistent. 

/~ 
The information management and synchronous communications system of 

claim_)'( wherein information entered on at least one Web page and transmitted over the internet 

is automatically communicated to the central database and at least one wireless handheld 

computing device. 

- 34-
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I~ 
fi The information management and synchronous communications system of 

2 claim y wherein information entered on at least one wireless handheld computing device is 

3 automatically communicated to the central database and at least one Web page . 

• 

-35 -
490392_1 

Petitioners' Exhibit 1006, Page 41 



ABSTRACT 

2 An information management and synchronous communications system and 

3 method fac ilitates database equilibrium and synchronization with wired, wireless and Web-based 

4 systems, user-friendly and efficient generation of computerized menus and reservations for 

5 restaurants and other applications that utilize equipment with nonstandard graphical formats, 

6 display sizes and/or applications for use in remote data entry, information management and 

7 communication with host computer, digital input device or remote pager via standard hardwired 

8 connection, the internet, a wireless link or the like. 

I 
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Docket No. 3 I 25-4002 

COMBINED DECLARATION AND POWER OF A DORNEY FOR 
ORIGINAL, DESIGN, NATIONAL STAGE OF PCT, SUPPLEMENTAL 

QJVISIQNAL, CQNU NJ !ATIQN QR CONIIN1JATION-£N-PA RT APPI .!CATION 

As a below name inventor, I hereby declare that 

My residence, post office address and citizenship are as stated below next to my name, 

1 believe I am the original, flist and sole inventor (if only one name is listed below) or an original, first and joint 
inventor (if plural names are listed below) of the subject matter which is claimed and for which a patent is sought on 
the invention entitled: 

INFORMATION MANAGEMENT AND SYNCHRONOUS COMMUNICATIONS SYSTEM WITH MENU 
GENERATION 
the specification of which 

a. [ X ] is attached hereto 

b. [ ] was filed on ___ as application Serial No. _ ____ and was amended on 

- - - - - -----· (if applicable). 

PCTFILED APPLICATION ENTERTNG NATIONAL STAGE 

c. [ ] was described and claimed in International Application No. _ ____ filed on ___ and 
as amended on . (if any). 

I hereby state that I have reviewed and understand the contents of the above-ident ified specification, including the 
claims. as amended by any amendment referred to above. 

I acknowledge the duty to disclose information which is material to the patentability as defmed in Title 37, Code of 
Federal Regulations, § 1.56. 

I hereby specify the following as the correspondence address to which all communications about this application are 
to be directed: 

SEND CORRESPONDENCE TO: 

DIRECT TELEPHONE CALLS TO: 
(212) 758-4800 

MORGAN & FINNEGAN, L.L.P 
345 Park Avenue 
New York, N.Y. 101 54 

[ ] I hereby claim fore ign priority benefits under Title 35. United States Code§ 119(a)-(d) or under 
§ 365(b) of any foreign application(s) for patent or inventor's cert ificate or under§ 36S(a) of any PCT international 
application(s) designating at least one country other than the U.S. listed below and also have identified below such 
foreign application(s) for patent or inventor's certificate or such PCT international application(s) filed by me on the 
same subject maner having a filing date within twelve ( 12) months before that of the application on which priority is 
claimed: 

[ 1 The attached 35 U.S.C. § 119 claim for priority for the application(s) listed below forms a part of this 
declaration. 
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c 
IC 
+ 

Cquntzy/PCT 
Application 

Number 
Date of filing 

{day month yr\ 
Date of Issue 

(day. month yr) 
Priority 
Claimed 

[ 1 YES I ] NO 

( ) YES ( ] NO 

[ ] YES [ ] NO 

( 1 I hereby claim the benefit under 35 U.S.C. § 119(e) of any U.S. provisional application(s) listed below. 

Provjsjonal Application No. Date of Filine (day. month. yrl 

Q ADDITIONAL STATEMENTS FOR DIVISIONAL, CONTfNUATION OR CONTfNUATION-fN-PART 
Q OR PCT INTERNATIONAL APPLICATION(Sl <DESIGNATING THE U.S.\ 

+ 
~ I hereby claim the benefit under T itle 35, United States Code § 120 of any United States application(s) or under 
W § 365(c) of any PCT international application(s) designating the U.S. listed below . 

• 
USIPCT Application Serial No. Filing Date 

US!PCT Application Serial No. Filing Date 

Starus (patented, pending, abandoned)/ 
U.S. application no assigned (For PCT) 

Status (patented, pending, abandoned)/ 
U.S. application no. assigned (For PCT) 

[ 1 In d1is continuation-in-part application, insofar as the subject matter of any of the claims ofd1is 
application is not disclosed in the above listed prior United States or PCT international application(s) in the manner 
provided by the first paragraph of Title 35, Uni ted States Code, § 112, I acknowledge the duty to disclose material 
information as defined in Title 37, Code of Federal Regulations, § I .56( a) which occurred between the filing date of 
the p rior application(s) and the national or PCT international filing date o f this application. 

I hereby declare that all statements made herein of my own knowledge are true and that all statements made on 
information and belief are believed to be true; and further that these statements were made with the knowledge that 
willful false statements and the like so made are punishable by fine or Imprisonment. or both, under Section 1001 of 
Title 18 of the United States Code and that such willful false statements may jeopardize the validity of the 
application or any patent issued thereon. 

I hereby appoint the following attorneys and/or agents with full power of substitution and revocation, to prosecute 
this application, to receive the patent, and to transact all business in the Paten! and Trademark Office connected 
therewith: John A. Diaz (Reg. No. 19,550), John C. Vassil (Reg. No. 19,098), Alfred P. Ewert (Reg. No. 19,887), 

-2-
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David H. Pfeffer (Reg. No. 19.825), Harry C. Marcus (Reg. No. 22,390), Robert E. Paulson (Reg. No. 2 1 ,046), 
Stephen R. Smith (Reg. No. 22,61 5), Kurt E. Richter (Reg. No. 24,052), J. Robert Dailey (Reg. No. 27,434), Eugene 
Moroz (Reg No. 25,237), John F. Sweeney (Reg. No. 27,471), Arnold I. Rady (Reg. No. 26,601), Christopher A. 
Hughes (Reg. No. 26,9 14), William S. Feiler (Reg. No. 26,728), Joseph A. Calvaruso (Reg. No. 28,287), James W. 
Gould (Reg. No. 28,859), Richard C. Komson (Reg. No. 27,9 13), Israel Blum (Reg. No. 26,710), Bartholomew 
Verdirame (Reg. No. 28,483), Maria C.H. Lin (reg. No. 29,323). Joseph A. DeGirolamo (Reg. No. 28.595). Michael 
P. Dougherty (Reg. No. 32, 730), Seth J. Atlas (Reg. No. 32,454 ), Andrew M. Riddles (Reg. No. 3 1,657), Bruce D. 
DeRenzi (Reg. No. 33 ,676), Michael M. Murray (Reg. No . 32,537), Mark J. Abate (Reg. No. 32,527), Alfred L. 
Haffner, Jr. (Reg. No. 18,919), Harold Haidt (Reg. No. 17,509), John T. Gallagher (Reg. No. 35,516), Steven F. 
Meyer (Reg. No. 35,61 3) and KeMeth H. SoMenfe ld (Reg. No. 33.285) of Morgan & FiMegan, L.L.P. whose 
address is: 345 Park Avenue, New York, New York, 10154; and Edward A. PeMington (Reg. No. 32,588), Michael 
S. Marcus (Reg. No . 31,727) and John E. Hoe! (Reg. No. 26,279) of Morgan & FiM egan, L.L.P. , whose address is 
1775 Eye Street, Suite 400, Wash ington, D.C. 20006. 

[ ) I hereby authorize the U.S. attorneys and/or agents named hereinabove to accept and follow instructions 

from --------------:----:--~---:---:---:~c--:::'----:c=·-:---:--=-c 
-----..,.--..,.,.-- - ----,,.-- as to any action to be ta ken in the U.S. Patent and Trademark Office 
regarding this application without d irect communication between the U.S. attorneys andlor agents and me. 
In the event o f a change in the person(s) from whom instructions may be taken I will so notify the U.S. 
attorneys andlor agents hereinabove. 

Full name o f sole or fi rst inventor Kei th R. McNally 
-----------~-------------------------------

Inventor's signa ture* 
date 

Residence 21 567 Parvin Drive, Santa Clarita, CA 91 3 SO 

Citizenship USA -----------------------------------------------------------------
Post Office Address 

Full name of second joint inventor, if any Wtll iam H. Roo f ----------------------------------------------
Inventor' s signature • 

date 
Residenct: 13429 Luckett Court, San Diego, CA 92130 

Citizenship USA -------------------------------------------------------------
Post Office Address 

Full name o f Lhird joint inventor, if any Richard Bergfeld 
--------~-------------------------------------

Inventor' s signature• 
date 

Residence 20719 Nashville Court, Chatsworth, CA 9 13 11 

Citizenship USA ------------------------------------------------------------------3-
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Post Office Address 

[ 1 A TI ACHED IS/ ARE ADDED PAGE(S) TO COMBINED DECLARATION AND POWER OF 
A TIORNEY FORM FOR SIGNATURE BY FOURTH AND SUBSEQUENT INVENTORS 

• Before signing th is declaration, each person signing must: 

I. Review the declaration and verify the correctness of all information therein; and 

2. Review the specification and the claims, including any amendments made to the claims. 

After the declaration is signed, the specification and claims are not to be a ltered. 

To the inventor(s): 

The following are cited in or pertinent to the declaration attached to the accompanying application: 

Title 37 Code of Federal Re&ulation. § 1.56 

Duty to disclose information material to patentability. 

492351 _ 1 

(a) A patent by its very nature is affect with a public interest. The public interest is best served, and 
the most effective patent examination occurs when, at the time an application is being examined, the Office 
is aware of and evaluates the teachings of all information material to patentability. Each individual 
associated with the filing and prosecution of a patent application has a duty of candor and good faith in 
dealing with the Office, which includes a duty to disclose to the Office all information known to that 
individual to be material to patentability as defmed in this section. The duty to disclose information exists 
with respect to each pending claim until the claim is canceled or withdrawn from consideration, or the 
application becomes abandoned. Info rmation material to the patentability of a claim that is canceled or 
withdrawn from consideration need not be submitted if the information is not material to the patentability 
of any claim remaining under consideration in the application. There is no duty to submit information 
which is not material to the patentability of any existing claim. The duty to disclose all information known 
to be material to patentability is deemed to be satisfied if all information known to be material to 
patentability of any claim issued in patent was cited by the Office or submitted to the Office in the manner 
prescribed by§§ 1.97(b)-(d) and 1.98. However, no patent will be granted on an application in cormection 
with which fraud on the Office was prac ticed or attempted or the duty of disclosure was violated through 
bad faith or intentional misconduct. The Office encourages applicants to carefully examine: 

(I ) prior art cited in search reports of a foreign patent office in a counterpart application, and 

(2) the closest information over which ind ividuals associated with the filing or prosecution of 
a patent application believe any pending claim patentably defmes, to make sure that any 
material information contained there in is disclosed to the Office. 

-4-
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IiiJe 35 U.S Code§ 101 

Inventions patentable 

Whoever invents or discovers any new and useful process, machine, manufacture, or composition of 
matter, or any new and useful improvement thereof, may obtain a patent therefor, subject to the conditions and 
requirements of this title. 

Iitle 35 () S Code§ 102 

Conditions for patentability; novelty and loss of right to patent 

A person shall be entitled to a patent unless -

(a) the invention was known or used by others in th is country, or patented or described in a printed 
publication in this or a foreign country, before the invention thereof by the applicant for patent, 

(b) the invention was patented or described in a printed publication in this or foreign country or in 
public use or on sale i.n this country, more than one year prior to the date of application for patent in the United 
States, or 

(c) he has abandoned the invent ion, or 

(d) the invention was first patented or caused to be patented, or was the subject of an inventor's 
certificate, by the applicant or his legal representatives or ass igns in a foreign country prior to the date of the 
application for patent in this country on an application for patent or inventor's certificate field more than twelve 
months before the fil ing of the application in the United States, or 

(e) the invention was described in a patent granted on an application for patent by another filed in the 
United States before the invention thereof by the applicant for patent, or on an international application by another 
who has fulfilled the requirements of paragraphs (I), (2), and (4) of section 371(c) of this title before the invention 
thereof by the applicant for patent, or 

(f) he did not himself invent the subject matter sought to he patented, or 

(g) before the applicant 's invention thereof the invention was made in this country by another had not 
abandoned, suppressed, or concealed it. In de termining priority of invention there shall be considered not only the 
respective dates of conception and reduction to practice of the invention, but also the reasonable diligence of one 
who was first to conceive and last to reduce to practice, from a time prior to conception by the other ... 

Title 35 U S. Code § I 03 

Conditions for patentability; non-obvious subject matter 

A patent may not be obtained though the invention is not identically disclosed or described as set forth in 
section 102 of this title, if the diffe rences between the subject matter sought to be patented and the prior art are such 
that the subject matter as a whole would have been obvious at the time the invention was made to a person having 
ordinary skill in the art to which said matter pertains. Patentability shall not be negatived by the manner in which 
the invention was made. 

Subject matter developed by another person, which qualifies as prior art only under subsection (f) or (g) of 
section I 02 of this title, shall not preclude patentability under this section where the subject matter and the claimed 

-5-
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invention were, at the time the invention was made, owned by the same person or subject to an obligation of 
assignment to the same person. 

Jjtle 35 U.S. Code § 11 2 On pan) 

Specification 

The specification shall contain a written description of the invention, and of the manner and process of 
making and using it, in such full , clear, concise and exact tenns also enable any person skilled in the art to which it 
pertains, or with which it is mostly nearly connected, to make and use the same, and shall set forth the best mode 
contemplated by the inventor of canying out his invention. 

Jitle 35 U S Code§ 119 

Benefit of earlier filing date in foreign country; right of priority 

An application for patent for an invention fi led in this country by any person who has, or whose legal 
representatives or assigns have, previously regularly filed an application for a patent for the same invention in a 
foreign country which affords similar privileges in the case of applications filed in the United States or to citizens of 
the United States, shall have the same effec t as the same application would have if filed in this country on the date 
on which the application for patent for the same invention was ftrst filed in such foreign country, if the application in 
this country is filed within twelve months from the earl iest date on which such foreign application was filed; but no 
patent shall be granted on any application for patent for an invention which had been patented or described in a 
printed publication in any country more than one year before the date of he actual filing of the application in this 
country, or which had been in public use or on sale in this country more than one year prior to such filing. 

Title 3 5, U.S. Code § 120 

Benefit or earlier filing date in the United States 

An application for patent for an invention disclosed in the manner provided by the ftrst paragraph of section 
112 of this title in an application previously filed in the United States, or as provided by section 363 of this title, 
which is filed by an inventor or inventors named in the previously filed application shall have the same effect, as to 
such invention, as though filed on the date of the prior application, if filed before the patenting or abandorunent of or 
termination of proceedings on the first application or an application similarly entitled to the benefit of the filing date 
of the first application and if it contains or is amended to contain a specific reference to the earlier filed application. 

Please read carefully before signing the Declaration attached to the accompanying Application. 

If you have any questions. please contact Morgan & Finnegan, L. L.P. 

f ORM:COMB-DEC.NY 
Rev. 5/2 1/98 
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Docket No. 3 1 25-40QI~ ~ 
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IN THE UNITED STATES PATENT AND TRADEMARK OfFICE 

Applicant( s) Keith R. McNally et al. Group Art Unit: TBA 

Serial No. TBA Examiner: TBA 

Filed 

For 

September 21, 1999 

INFORMATION MANAGEMENT AND SYNCHRONOUS 
COMMUNICATIONS SYSTEM WITH MENU GENERATION 

STATEMENT(DECLARATION) CLAIMING SMALL ENTITY STATIJS 
3 7 CFR § l 97(0 AND § 1.27 (c)) - SMALL BUSrNESS CONCERN 

I hereby state that I am 

[ I the owner of the small business concern identified below: 

[ X ) an official of the small business concern empowered to act on behalf of the concern identified 
below 

NAME OF CONCERN AMERANTH TECHNOLOGY SYSTEMS, fNC. 

ADDRESS OF CONCERN 12230 El Camino Rea~ Suite 330; San Diego, California 92130-2090 

T" -

I hereby state that the above identified small business concern qualifies as a small business concern as defmed in 13 
CFR §§ 121.3-18, and reproduced in 37 CFR § 1.9(d), for purposes of paying reduced fees under section 41(a) and 
(b) of Title 35, United States Code, in that the number of employees of the concern, including those of its affiliates, 
does not exceed 500 persons. For purposes of this statement, (I) the number of employees of the business concern 
is the average over the previous fascal year of the concern of the persons employed on a full-time, part-time or 
temporary basis during each of the pay periods of the ftScal year, and (2) concerns are affiliates of each other when 
either, directly or indirectly, one concern controls or has the power to control the other, or a third party or parties 
controls or has the power to control both. I hereby state that exclusive rights under contract or law have been 
conveyed to and remain with the small business concern identified above with regard to the invention entitled: 

INFORMATION MANAGEMENT AND SYNCHRONOUS 
COMMUNICATIONS SYSTEM WITH MENU GENERATION 

inventor( s) 

described in 

[ X I the specification filed herewith 

by: Keith R. McNally 
William H. Roof; 
Richard Bergfeld 

( 1 application Serial No. - - - - --- ------• filed -:--- - ---- ---
[ ] Patent No. , issued---------

492100_1 
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